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| Read This First

B Disclaimer

» While every effort has been made to ensure that the information contained in this
guide is accurate and complete, no liability can be accepted for any errors or
omissions. Canon reserves the right to change the specifications of the hardware
and software described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

» Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software, memory
cards (SD and SDHC Cards), personal computers, or peripheral devices, or due
to use of a memory card not initialized by a Canon camcorder.

B Trademark Acknowledgments

* Microsoft, Windows, Windows Media and Windows Vista are trademarks or
registered trademarks of Microsoft Corporation in the United States and/or other
countries.

* The SD logo is a trademark. The SDHC logo is a trademark.

» Other names and products not mentioned above may be registered trademarks
or trademarks of their respective companies.

© Canon Inc. 2010 All rights reserved.

B Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support data
CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could

damage the speakers. It is also possible to suffer from hearing loss from listening
with headphones to the loud sounds of a CD-ROM played on a music CD player.

Checking Supplied Accessories

Use the following accessories to download recorded still images from the camcorder
to your computer.

» Supplied USB cable o G0/ GEND / IO /CIITED / CIITED / CIIERD
The cable supplied with your Instruction Manual/Photo Applications
camcorder may be different from the  Ver. 34/Music Data Disc
one described in this manual. S HF S20 JAHF S21HIHF 5200

Photo Applications Ver. 34/Music Data

Disc

The explanations in this manual use mainly Windows XP screen shots. The steps
and windows may vary depending on your computer and the version of software.
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| System Requirements

Install the software on a computer meeting the following minimum requirements.

0OsS: Windows 7
Windows Vista (including Service Pack 1 or 2)
Windows XP (Service Pack 2 or 3)
* Proper operation is not guaranteed on an OS that has
been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.

CPU: Pentium 1.3 GHz or better

RAM: Windows 7 64-bit: 2 GB or more

Windows 7 32-bit / Windows Vista: 1 GB or more
Windows XP: 512 MB or more

Interface: USB

Free Hard Disk Space: + Canon Ultilities
- ZoomBrowser EX: 200 MB* or more

Display: 1024 x 768 pixels/High Color (16 bit) or better
* When using Windows XP, you must install Microsoft .NET Framework 2.0 or later (up

to 500 MB). Depending on your operating environment, installation times may be
longer.

{0} O Proper operation is not guaranteed on any particular system, even if it meets
the requirements outlined above.
O A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

Microsoft Windows 7: Windows 7
Microsoft Windows Vista (including Service Pack 1 or 2): Windows Vista
Microsoft Windows XP (Service Pack 2 or 3): Windows XP

System Requirements I 5



| What is Photo Application?

Photo Application allows you to download still images you recorded with the
camcorder to a computer and manage, print, and edit them.

B ZoomBrowser EX

* Viewing still images as thumbnails

* Managing by shooting date folders with still images

 Categorizing, organizing, and searching large volumes of still images
* Printing still images

* Editing still images

» Changing the data for still images and save them as new files

« Attaching still images to e-mail

* Viewing still images in a slide show

» Adding sound to a still image

B CameraWindow

* Downloading still images to your computer
* Viewing still images saved on the camcorder and deleting them

This instruction manual explains how to install the software, what you can do with the
main features and how to operate them. For more detailed operational instructions,
refer to the Help menu of each software program.

5 Your camcorder may not support some features of the software.
g
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| Windows

CameraWindow

After you connect the camcorder to your computer, you can use CameraWindow to
download still images to the computer. Furthermore, you can delete still images saved
on the camcorder, without having to download them to the computer, and you can
upload still images from the computer to the camcorder ([]] 56). You can also confirm
and change the owner's name of the camcorder you specify ([ ] 63). Refer to Starting
CameraWindow ([ 1] 28) for launching the software.

B [Import Images from Camera] Window

After you connect the camcorder to your computer, use this window to download still
images to the computer.

Download selected images.
Download only the images not yet imported to the computer.

& Canon Utilities CameraWindow DC

Card Capacity:

’ 4.25 MB [ 3.74 GB Madel Name: Canon s s
l:l Firmware Version: 1.0.0.0

Owiner's Nama:
Untransferred Images: 3/3 Battery Capacity: AC adapter

[3]  Import Untransferred Images

@ Import Images from Camera [] Select Images to Import

B2 import All Images

Download all images.

Windows I 7



B [Organize Images on Camera] Window

Delete still images saved on the camcorder, without having to download them to the
computer, and upload still images from the computer to the camcorder.

& Canon Utilities CameraWindow DC

Menu
e e 0
|

Card Capacity:
Modsl Name: Canon sssess

. 435 M8 / 3.74 GB

Firmware Version: 1.0.0.0
Owiner's Name:
Untransferred Images: 3/3 Battery Capacity: AC adapter

Organize Images on Camera (™ Organize Images

8 I Windows



B [Import Images from Camera] Window

Return to the CameraWindow menu screen. Display the Help menu.

Configure Preferences settings _____
(camcorder owner's name and download destination, etc.).

Adjust the size of the thumbnails.

Toggle the shooting date/time and file name displays.

s Canon Utilities CameraWindow DC _

Card Capacity:

' 4.25MB [ 3.74 GB
]

Untransferred Images: 3/3

(2] All tmages (3)
El Untransferred Images (3}

» [[3 Image Type

» (5 Folder

Select all still images.

Clear still image selections.

Download images to the computer.

Windows I 9



B [Organize Images on Camera] Window

Return to the CameraWindow menu screen. Display the Help menu.

Configure Preferences settings ——
(camcorder owner's name and download destination, etc.).

Adjust the size of the thumbnails.

Toggle the shooting date/time and file name displays.

w Canon Utilities CameraWindow DC _

. 4.25MB [ 3.74 GB
T

Untransferred Tmages: 3/3

2] All tmeges (3}
Untransferred Images (3)

» [ Image Type
» (3 Folder

Upload selected still images to the camcorder.

Delete still images on the camcorder.
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Main Window

ZoomBrowser EX is a software program used for organizing, printing and editing the

downloaded still images. If you wish to start ZoomBrowser EX without connecting the

camcorder or card reader/writer, double-click the

[
-,
£

oomBramser

on the desktop, or click the

Windows [start] menu and select [All Programs] » [Canon Utilities] » [ZoomBrowser
EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click Eﬂ or select [Exit] from

the [File] menu.

#1 ZoomBrowser EX - C:\Documents and SettingsboodMy DocumentsiMy Pictures

File Edit Wiew Tools Internst  Helo

(Tasks 'f@

8| Acquirs & Camera Settings ]

I \w View & Classify ]

1 I '—= ‘ Edit ]
I.‘;v Export ]

% Pinth Emai ]

|f: CANDIN IMAGE GATEWAY 1

\_ J/
(LastA:quued Images f:.)

= &) Al Images
=[] Shonting Date
5] 200%.0 15

Favarte Folders | &)l Folders
[=- {3 my Pictures
3] 200%_01_15
5 200x_01_20
F Search Results

eeeee

= . hY
( ;:j sideshon | ¥ soarch | 6
\
(| ZsomMode | Serclibads | Previen Mode) | : 5
kMy Pictures GO0 HR-8-[k]® Dt | &F Fiter )
g) 200%_01_15

IMG_D107.JPG IMG_0108.JPG

IMG_0109.0PG  MWI_D106.8VI

Selected Ttems: 0

1 Task Area
[Acquire & Camera Settings]:

[View & Classify]:

[Edit]:
[Export]:

[Print & Email]:

[CANON iMAGE GATEWAY]:

Use this to display the Camera Control window to
download still images, to print still images without
having them downloaded to the computer and to
configure the camcorder settings.

Use this to view and organize still images.
Use this to edit still images.

Use this to change the data for still images and
save them as new files, back up to CD-R/RW, or
export shooting properties to a text file.

After you download still images to a computer,
use this to print them or to attach them to e-mail
messages.

Use this to connect to CANON iMAGE
GATEWAY.
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Folders Area

You can select a folder to be displayed in the Browser Area. In the [Last Acquired
Images] panel, the newly downloaded still images are placed into virtual folders
classified by recording date. In the panel below, the folders where the downloaded
still images are actually saved in are displayed. Selecting the [Favorite Folders] tab
shows only the folders that are registered as favorites. The [All Folders] tab shows all
available folders. _'I_', indicates that newly downloaded still images are in the folder.
To register folders as Favorites, follow the instructions below.

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

To remove the registered folder, select the folder, and click [Remove].

Browser Area

This area displays the images contained in the selected folder. If you place the
cursor over a thumbnail in the browser area, will be displayed at the upper right
corner. Clicking skips over folders to zoom in directly on the intended folder.

2Py © Clicking on 2 images while holding down the [Shift] key selects also all

& images between the 2 images.
o Clicking on different images while holding down the [Ctrl] key selects multiple
images.
4 Image display control panel
The menu items vary depending on the View Mode.
1 2 3 4 5 6 7 8
1 | L . I W — I
Q Q0 R-0- k|5 | O | [ || §F Filer -
1 | Previous/Next Displays the previous/next image in the current folder.
2 |Up Displays the folder in the upper tiers of the hierarchy.
3 | Select Allows you to select all images and deselects images.
4 | Information Allows you to select the information to be shown. You can
also hide the pop-up window by clearing the check box.
The pop-up window appears when you move the pointer
over a thumbnail.
5 |Pan Changes the area displayed when you zoom in on a folder

or image in the Browser Area and drags the thumbnail list.

Restore Display Size | Changes the size of the thumbnail list to fit the window.

Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.

Filter Allows you to select which still images to display
according to the star rating. When you download the
images, the star rating is set to two stars as a default. To
change the star rating, refer to Applying Star Ratings and
Keywords ([ 1] 41).

Windows




5 View Mode
You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

Zoom bed= [ crol Mods | Preview Mo | -
My Pictures Q Q Lﬂ i B |_L§_ 1€ j—-—-—’" ﬁ% Fiter =

‘ ¥ 200¢_01_15

MG_0101.0PG [MG_(1102, PG

e E3

MG_0103.0PG IMG_0104,1PG

[ 200¢_01_20

[Scroll Mode]: Double clicking a folder shows thumbnails of the still images inside.

| Zoom ods | Serollode | Preview bade|

My Pictures @ 0 E@ X ﬁ = }——‘"’ .f;f Filter =

o | .

200 _01_15  200%._01_20

[Preview Mode]: Double clicking the folders at the bottom of the window opens the
folder and shows a large still image in the folder along with detailed information.
You can change file name and comments. To display another image, click
[Previous]/[Next] or select an image shown at the bottom of the window.

| Zoom Mods | Seral Mode | Freview Mods |

200% 01 15 Q Q HN-8- Friw - 1

& File Intormation: A
Flellans. M3 001
Modified: 118/2008 [ Protect
File Size: 82.8KE

Image Size: 540« 480

Data Type: JPG

Sound:

[ Star Rating:

[Z] Comment:
>
[¥] Keywaords:

2] Brightness Histagram

| Shioating Intormation:
| Item Name Walue

i | | File Mame IMG_0T01.JPG I

He | Camera Model Name  Ganon k4 & |

g IMG_0102.0PG IMG_0103,3PG IMG_0104.0PG
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6 Command buttons

1

2 3 4 5 6

;.'u'iew Image ‘_E_E.:.=Prnperties Q| Slide Show ;."'!'f Search ¥ Delste '-ﬁ' Rotate

=

View Image

Displays a selected image in the [Image Viewer] window.

2 | Properties

Displays properties of the selected still image. When you
select a different image while the [Properties] window is
open, the information switches to the one of the selected
image. The [Properties] window cannot be displayed in
[Preview Model].

B Properties 3

Modiied 1/15¢200¢
= Fie Size 828K8
ImageSizer G40 480
Data Type JPB
Sound

=

[ viewimage. | [JPrtect
Path:  C:\Documents and Sefingsass\My Docume

(] File Name:

IME_0101

[Z] StarRating

[Z] Comment:

[E] Keywords:
View/Modify Keprords

[Z] Brighiness Histogram:

.

L —

[Z] Shaating Infomation:

Value ~
MB_D101.JFG
e Canon ¥+
Time  1{15/200% 9.2550 AM
420

B
<RGR b/

3 | Slide Show Displays still images in a slide show.

4 | Search Allows you to search for images ([]] 46).

5 | Delete Deletes selected images.

6 | Rotate Rotates selected still images. A movie cannot be rotated.

14 I Windows




[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View Image]
or double-click an image.

1 2 3 4 5 617 8 9

@‘M v B
ile:
G O W B e~ | o @l (o [OE M 00 EH)

N B ,'r]IMG_DlDl‘JPG(l,M)

Zoom Ratio: 100%

Previous/Next Displays the previous/next image in the current folder.

Zoom In/Zoom Out | Enlarges/Reduces a still image.

Pan When the image is larger than the window, you can move
the image in the desired direction.
4 | Print Prints the selected still image. Refer to [Photo Print]
(11 37).
5 | Edit Allows you to perform the following operations: red-eye

correction, auto correct, color and brightness correction,
sharpness adjustment, trimming, inserting text, or
registering external image editing applications.

6 | Auto Focus Frame | This function cannot be used for the images recorded by
the camcorder.

7 | Shooting The shooting information of the image will be displayed.
Information
Show Allows you to display multiple images at the same time.
Synchronize Synchronizes the View functions across all displayed
images.

Windows I 15



10 | Fit to Window Matches the image size to the size of the Image Viewer

Window.
11 | Restore Restores the standard display size.
12 | Zoom Slider Allows you to enlarge/reduce the displayed image.
13 | Show Image Full Displays an image in full screen size.

Screen

14 | Change the Star Allows you to change the star rating.
Rating

oys Windows 7/Windows Vista: The star rating set using ZoomBrowser EX is not
4 related to the “Rating” setting in Windows Photo Gallery and Windows
Explorer.

B [Red Eye Correction] Window
Select [Red Eye Correction] from the [Edit] menu, or click the e~ icon and
select [Red Eye Correction]. Use this to correct still images in which people’s eyes

appear red.
1
2
[ Shaw Original Image:
Auto Mode Clicking [Start] corrects the red eye effect automatically.
2 | Manual Mode Point the cursor on a red eye so that the area is
highlighted green, and click the mouse button.

16 I Windows



B [Auto Adjustment] Window

Select [Auto Adjustment] from the [Edit] menu, or click the £ =~ icon and select
[Auto Adjustment]. Use this to automatically correct the color balance of the still

image.

= Auto Adjustment - C:\Documents and Settingsbood\My Documents\My Pictures\200¥%_01_15\IMG_01... - |EHZ|

Auta Adjust Image

B [Color/Brightness Adjustment] Window

Select [Color/Brightness Adjustment] from the [Edit] menu, or click the .£e - icon
and select [Color/Brightness Adjustment]. Use this to adjust the brightness,
saturation, contrast, intensity levels, tone curve and RGB of the still image.

[= Color/Brightness Adjustment - C:\Documents and Settings\ooc\My Documents\My Pictures\200X_01... - ‘E||g|
¥l
Brighthess: 7]7 |D = |
Saturatior: 37 o s
Contrast: ji 0 =
L =R = ..-njﬂ
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B [Sharpness] Window
Select [Sharpness] from the [Edit] menu, or click the £e- icon and select
[Sharpness]. Use this to emphasize and clarify the outlines of people and objects.

= Sharpness - C:\Documents and Settingsbood\My Docume nts\My Pictures\200X_01_15\IMG_0104.JPG ‘:”E]@

shaipen | Unsharp Mask |
Amount: :] |U__:
+-» 3 =] _,__.j-'——_‘

B [Trim Image] Window
Select [Trim] from the [Edit] menu, or click the e~ icon and select [Trim].
Specify the area in the still image to crop and click [Trim Image] to trim the image.

=] Trim Image - C:\Documents and Settings\oo\My Documents\My Pictures\200X_01_15\IMG_0103.JPG |z||@@

The image will be timmed ta the area shawn inside
the: trim biox

1. Moave and resize the tim box in the preview area.
F¥1  Advanced Options

2. Click Trir Image to apply the settings.

Trirm Image

3. Click DK to cloge this panel

Cancel

"'_'_‘ L ELS =, r—jr—""'
Zoom Ratio: 70% B4 48 \width: 512, Height: 384
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B [Insert Text] Window

Select [Insert Text] from the [Edit] menu, or click the £ - icon and select [Insert
Text]. Use this to write text on still images.

[= Insert Text - C:\Documents and Settingsboo\My Documents\My Pictures\200X_01_15\IMG_0104.JPG \:”E]@
Inzert Text

Font Harne: i_ ‘_'\
Farit Sizer |48 x|

Test Color: (|

Text Aftribute: B I U

Antislias

Tent

<Select the location an the image first, then
type your text in heres

7 _These image correction toqls can be selected by clicking [Edit] » [Edit Image]
= in Task Area of the main window.
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| Installing Photo Application

@ O Be sure to install Photo Application before connecting the camcorder to the
\ o / computer.

O You must have authorization as a Computer System Administrator to install
programs.

2P Your digital video camcorder is equipped with the standard Picture Transfer

Protocol (PTP). This protocol enables you to download still images by simply

connecting the camcorder to a computer with the USB cable (applications such

as the [Scanner and Camera Wizard] start automatically).

However, note that there are several limitations to downloading still images

with this method. To avoid these, install ZoomBrowser EX to download still

images.

o It may take a few minutes, after connecting the camcorder, until you can
download still images.

o Still images protected on the camcorder may lose this setting once they are
downloaded to the computer.

1 Check that the camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be
installed normally. If a camcorder is connected, detach the USB cable from the
computer.

2 Setthe (ED/ED/ CED /CEED/ CHED /GEED Instruction Manual/
Photo Applications Ver. 34/Music Data Disc D/ GED / (ED
Photo Applications Ver. 34/Music Data Disc in the
computer’s CD-ROM drive.

* Windows 7 / Windows Vista:

o When the [AutoPlay] window appears, select [Open folder to view files] to
open the folder, and then double-click [setup.exe]. Follow the instructions in
the [User Account Control] window that appears after a brief period.

o If the [AutoPlay] window does not open automatically, use the following
procedures to display it.

1) Select [Computer] from the Start menu.

2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.

3) Double-click the [setup.exe] icon.

4) Follow the instructions in the [User Account Control] window that
appears.
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* Windows XP:
O The folder appears automatically.
Double-click the [setup.exe] icon.
o If the folder does not open automatically, use the following procedures to
display it.
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [setup.exe] icon.

Depending on your computer’s settings, the file extension “.exe” may not
appear.

3 Select your country or region.
4 Select your language.

5 Click [Easy Installation] under Photo Application.

To specify the installation folder, click [Custom Installation].

Canon
Installer Panel —— Photo Application

e oY
(  Easy Installation

— T orare.

Custom Installation
4
i’

Select the software that you want toinstall,

CANON IMAGE GATEWAY

( Register \)
-

Exit

6 If other software is running, close all programs and click
[OK].

Start instaling ZoomBrowser EX,
Close any other open applications and click [OK].

Installing Photo Application I 21




Review the installation settings and click [Install].

Confirmation

E@ ZoomBrowser EX 200 MB

step 2  License

step 3  Installation
St<'p4 Registration
step 3 Finish

iew a description of the software by passing your mouse over the name of the
software.

C:\Program Files\Canon,

Click [Install] to start installing.

€ v

Read the license agreement and click [Yes] to accept the
terms and to start installation.

License Agreement

Please read the folowing License Agreement carefully before instaling the
saiftware.

License IMPORTANT NOTICE

This software contains the Adobe color profiles (adobe RGB(1996), Apple RGE,
ColorMatch RGB, Wide Gamut RGR), and which are licensed under the Folowing

stepd  Installation Adobe SYSTEMS INCORPORATED COLOR PROFILE LICENSE AGREEMENT, This
software other than such Adobe colar profiles is licensed under the Following
Canon Software License Agresment,

stepd  Registration = 2
SOFT'WARE END LISER LICENSE AGREEMENT

) ATTENTION: PLEASE READ THIS DOCUMENT BEFORE INSTALLING THE
step B Finish SOFTWARE,

This is a license agreement between you and Canan Inc., having its place of
busingss at 30-2 Shimamarukn 3-chome, Ohtarkay, Tokyn 146-6501, Japan
("Canon’), with respect to the software (incuding any image data and sound data
included as park thereof, if any (the "Data")) and its associated printed materials
and "online” ar electranic dacumentation, if any (callectively, the "Saftware™).

BY INSTALLING THE SOFTWARE VOU AGREE TO BE BOUMD BY THE TERMS OF

THIS AGREEMENT. IF VOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
PROMPTLY CLOSE THIS INSTALLATION PROGRAM. IN SUCH CASE, THE

SOFTWARE WILL NOT BE INSTALLED AND VOU WILL HAYE MO RIGHT TOUSEIT,  |w

Click [Yes] to accept the License Agreement. If you dick [Mo], the installation
of ZoomBrowser EX wil be canceled,

No
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9 Click [Next].

Installation

o ZoomBrowser EX

stepd  Registration

Step 5 Finish

Installation has completed
successfully.

10 When the installation is complete, make sure [Restart
computer immediately (Recommended)] is selected and
then click [Restart].

Installation of the software has been completed.

[ Restart computer immediately (Recommen ded))
= m
———

When you do not need to restart the computer, the [Finish] screen will be
4 displayed. Click [Finish]; remove the GHD/GEID/ CHINO /CHIED / CHYED / CIIED
Instruction Manual/Photo Applications Ver. 34/Music Data Disc G / GIE¥ /
Photo Applications Ver. 34/Music Data Disc from the CD-ROM drive,
and proceed to Before Downloading Still Images ([ ] 25).
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11 When the computer has restarted and the regular desktop
screen is displayed, remove the GEiD/CEID/CED /CHIED / CHIED /
Instruction Manual/Photo Applications Ver. 34/Music
Data Disc 0/ /@@ Photo Applications Ver. 34/Music
Data Disc from the CD-ROM drive.

When installation is complete, remove the GHND/GENED/ GHE00) /CIIED / CIED /
Instruction Manual/Photo Applications Ver. 34/Music Data Disc GE0/

/@@ Photo Applications Ver. 34/Music Data Disc before you connect
the camcorder to the computer.
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| Before Downloading Still Images

Connecting the Camcorder to a Computer

@ O Be sure to install Photo Application before you connect the camcorder to the
computer.

O Make sure the camcorder is being powered using the power adapter before
connecting it to a computer.

o Connect the USB cable directly to one of the computer’s main USB ports.
The interface may not function correctly if the camcorder is connected via a
USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

0o Do not connect two or more camcorders to the computer. The camcorders
may not operate normally.

O Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface.

2% © Refer to your computer manual for the location of the computer’s USB ports.
4d o For details about changing settings on the camcorder and connecting the
camcorder to the computer, see the camcorder’s instruction manual.

B Settings on the Camcorder

Before connecting the camcorder to the computer, change the following camcorder
settings in advance.
* In the still images index screen, select which still images to play back (built-in
memory or memory card).
* In the [SYSTEM SETUP] menu, set [USB SETTING] to one of the following options.
- [PC/PRINTER]:
To simply connect the camcorder to the computer without further operations.
- [CONNECT&SET]:
Select [PC/PRINTER] on the camcorder every time you connect it to a computer.

B Connecting the Camcorder

1 Connect the compact power adapter to the camcorder.

2 If downloading images from a memory card, insert the
memory card into the camcorder.

3 Set the camcorder to still image playback mode.
Wait until the ACCESS indicator stops flashing.
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4 Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
» Restart the computer if you are prompted to restart it the first time you connect
the camcorder to the computer.
* A window appears allowing you to select an application program to start.
* For instructions on how to start ZoomBrowser EX and download images to the
computer, see Downloading Still Images ([ 1] 27).

USB Terminal USB Cable

~¢— Camcorder End Computer End —

USB Port on
the Computer

26 I Before Downloading Still Images



| Downloading Still Images

@ o Observe the following precautions when the camcorder’s access indicator is
¥ flashing. Failure to do so may cause data to become corrupted.

- Do not remove the memory card or detach the USB cable.

- Do not turn off the camcorder or the computer.

- Do not switch between the shooting and playback modes.

o The still images you recorded and/or downloaded to the hard disk are
important original data files. Create a copy of the file first before working on it
on your computer.

o Do not rotate the image using programs other than ZoomBrowser EX. The
data for the original image will be changed and the image can no longer be
displayed in ZoomBrowser EX or on the camcorder.

o If the Server Busy window appears when you connect the camcorder to the
computer, click [Retry].

O If the built-in memory or the memory card contains a large number of
images, the correct connection to the computer may not be possible. The
maximum number of images depends on the camcorder used, so please
refer to the relevant chapter in your camcorder’s Instruction Manual.

In such case, copy the images from the built-in memory to a memory card
and then use a card reader/writer to transfer the images to the computer. For
instructions on how to connect a card reader/writer, see Using a Card
Reader/Writer ([ 1] 33).

o The memory capacity that appears in the CameraWindow menu screen will
differ from the capacity that appears on the camcorder’s screen.
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Starting CameraWindow

1 Connect the camcorder to the computer ([ 25).

2 Select [Canon CameraWindow] and click [OK].

» Windows 7 / Windows Vista: When the [AutoPlay] window appears, click
[Downloads Images From Canon Camera using Canon CameraWindow].

* If a camcorder and card reader are connected at the same time, a dialog
appears allowing you to select the camcorder model. Confirm that [Canon
Camera] or your camcorder model name is displayed and click [OK].

Canon & & *

Camera connected

Select the program to launch far this action;

(5B

72 Microzoft Scanner and Camera YWizard
- Download pictures from a camera of scanner

[ hweavs uze this program for this action

Cancel

* The CameraWindow menu screen opens.

o If the camcorder is already connected to the computer, you can start
CameraWindow and display the CameraWindow menu screen by clicking
[Acquire & Camera Settings] followed by [Connect to Camera] in the main
window of ZoomBrowser EX.

O
4
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Downloading Still Images to the Computer

You can select a downloading method in the [Import Images from Camera] window.

B Downloading Untransferred Images
Download only the images not yet imported to the computer.

1 Connect the camcorder to the computer.

2 Click [Import Images from Camera] in the CameraWindow
menu screen.

When the download completion screen appears, click [OK] to close the
CameraWindow screen. The downloaded images will appear in the main
window of ZoomBrowser EX.
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B Downloading Selected Images
Download only the images that you select.

1 Click [Import Images from Camera] in the CameraWindow
menu screen.
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3 Select images for download in the [Import Images from
Camera] window, and click the [Import] button.

When the download completion screen appears, click [OK] to close the
CameraWindow screen. The downloaded images will appear in the main
window of ZoomBrowser EX.
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B Downloading All the Images on the Camcorder
Download all the images saved on the camcorder.

1 Click [Import Images from Camera] in the CameraWindow
menu screen.

2 Click [Import All Images].

When the download completion screen appears, click [OK] to close the
CameraWindow screen. The downloaded images will appear in the main
window of ZoomBrowser EX.
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Using a Card Reader/Writer

Select a download method in the image download window.

The basic operations are the same as when you connect the camcorder to the
computer. Follow the procedure below to open the CameraWindow. For instructions
on how to connect the card reader/writer, refer to its manual.

2Py If you are using SDHC cards, you need to use a card reader/writer compatible
Z :
o with SDHC cards.

1 Insert a memory card containing images recorded with the
camcorder into the card reader/writer and connect it to the
computer.

When a window appears allowing you to select an application program to start,
select [View/Download Images using Canon ZoomBrowser EX] and click [OK].

29y Clicking [Acquire & Camera Settings] » [Acquire Images from Memory Card]
4 in the main window of ZoomBrowser EX also opens the image download
window.

2 Selecta downloading method.

* [Download Images]: A progress bar will be displayed and images will be
downloaded to the computer, and ZoomBrowser EX starts. For instructions on
how to set the Auto-download settings, see Auto-Downloading Settings
([1134).

* [Lets you select and download images]: ZoomBrowser EX opens, displaying
the still images on the memory card as thumbnails (small images).

ZoomBrowser EX Canon

Download Images ‘

Lets you select and
download images

[ Print Menu ‘

Preferences... Exit
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B Auto-Downloading

1 Click [Download Images].
* For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ([ ] 34).
* Click [Exit] to close the window after downloading images.

ZoomBrowser EX Canon

e

| Download Images |

download images

[ Lets you select and ‘

[ Print Menu ‘

Preferences... @

B Auto-Downloading Settings

Select the setting for downloading images by operating your computer. You can
change the image type and the destination folder.

1 Click [Preferences].

ZoomBrowser EX Canon

[ Download Images ‘

Lets you select and
download images

[ Print Menu ‘
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2 Configure the settings and click [OK].

1 Preferences

[Images to Download]

| Mew images

[Save Location]

| C\Documents and Settingsiocd My Documentsi iy Pictures | [ Braowse, ., ]
Create Subfolder
Folder Mame and Folder Structure:
i-‘:nrhooting VearMonEHDate T

Example:

(] ChDocuments and Sebtingsixd iy D, \My Pictures
1] 200% 01 15

[Action After Download]

() Display the folder at the save destination

() Perform selected processes consecutively

[Other Settings]
[C5tart download automatically after connecting memary card

[ oelete images on memory card after download is complete

Cancel

The window below will be displayed when you select [Perform selected
processes consecutively] or [Select] under [Action After Download]. Select a
process to perform after the image is downloaded, and click [OK].

Select Process

Fleaze zelect a tazk to run after your images
hawve been downloaded:

(%) View az & Slide Show
) Phioto Print
{3 Index Frint
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B Downloading the Selected Still Images from ZoomBrowser EX

1 Click [Lets you select and download images].
ZoomBrowser EX opens.

ZoomBrowser EX Canon

Download Images ‘

| Lets you select ar you select and ]
download images

[ Print Menu ‘

Preferences... Exit

2 In ZoomBrowser EX, select the image you wish to download
and click [Image Download].

* Clicking on 2 images while holding down the [Shift] key selects also all images
between the 2 images.

* Clicking on different images while holding down the [Ctrl] key selects multiple
images.

i ZoomBrowser EX - H:\DCIM
File(Fy Edit(E) Wiew(¥) Help(H)

CBR

A blue frame
appears around
the selected image.

IMG 0102.JPG MG 0103.0PG MG 04 JPG

Selects image 1 of 4
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| Printing Still Images

You can select one of the following 2 methods to print still images.
* [Photo Print]

- Prints one still image per page.
* [Index Print]

- Prints selected images in rows with file names and image information.

2% You can select the program to use for printing by clicking [Print & Email] in the
<4 main window and selecting [Print Using Other Software].

B [Photo Print]

1 Click [Print & Email] in the main window and click [Photo
Print].

57 ZoomBrowser EX - C;\Documents and Settingsbocd\My Documents\My Pictures

File Edit View Tools Internet Help

Tasks @3‘9 1 ;etl Slide Shaw IFS’: Search
l i! Acquire & Camera Settings ] a0 Made [ Scroll Mode | Preview Made | B ) i - )
l Ju' Viei & Classify ] _.My Pictures Q Q BR-0- |E! L ]r—-—'f_ HW:: Fiter =
l & e ] ¥ 200%_01_15
l .__;;' Export ]

s Print & Email J ‘ o
bt
{ Index Print

Print Lzing Other S oftware ] H E H
4

Email Images IMG_D102.JPG IMG_0104.0PG

2 Select still images you wish to print and click [Printer and
Layout Settings].

57 ZoomBrowser EX - C;\Documents and Settingsbocd\My Documents\My Pictures

File ools  Internet Help

Wi
:§ Fhoto Print

[ 21 Retum to Main Menu ]I)-

Last Acquired Images [v]

Y
Folders | Al Folders ) —
3 e IMG_0108,0PG IMG_0104.1PG
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38

3 Specify the print settings and click [Print].

Selects the printer.

' ZoomBrowser EX -

C:\Documents and Settings\xoo\My Do

File Edit Wiew Tools Inkternet Help
F &

—— Sets the paper size settings.

:—a Phota Print Hlnter and Lad Jut
i y
1. Select Imagss Printer Fhoto Setlings and Preview
; Narme: @ Femove unwaniad Add or Modify text to
Eimtecsnd ot Se“mgs | Canon s v| regions of your photo printwith this phato,
Trim Image Insert Text
Properties
i Faper Size - Ad
phmh: Eﬂl_h ohe on:
Flﬁljﬂ
Click Properties to enahle
borderless printing on
Shoating Date/Time
|N0ne b
Froperies

Click this button to switch between still
images if multiple images are selected.

Copies \L :J

Total: 2 pages

Sets the number of print copies
of the displayed image.

| Al

Sets the shooting date/time imprint and color settings.
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B [Index Print]

1 Click [Print & Email] in the main window and click [Index

Print].

5 ZoomBrowser EX - C:\Documents and Settings\ox\My DocumentsiMy Pictures

File Edit View Tools Internet Help

@ @-e-@m e | §F i -

Tasks 6 | Vlew Imiags vepertes || Slide Show [\!ﬁ Search
l l—-Ja #EUIE & Lamera s etings ] miVSc:rDII Mode | Previesw Mods
[ W View & Classify ] MpREL e e
B ] N
: %] 200x_01_15
l:?-‘ Expart ] ;
[-ﬁj Print & Ernail ] m ‘
Phota Print N
[ J IMG_0101.JPG IMG_D102.0PG
| Index Print |
{ Frint Lzing Other S oftware 1 v
Email Images N MG 0103.JPG IMG_0104.1PG

2 Select the still images you wish to
and Layout Settings].

1" ZoomBrowser EX - C:\Documents and Settings\boodMy Documents\My Pictures

File Edit View Tools Internet Help

Index Frint

Zoom Mode | Seroll Mode | Preview Mods |

print and click [Printer

Select Images
My Pictures 0

@ =H-8-[k]% S §F il -

Printer and Lagout Settings

page.

I 21 Retum to Main Menu ]
Last Acquired Images @
Favorte Folders | All Foldsrs| {
-
= (13 My Pict
[P |
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3 Specify the print settings and click [Print].

— Rotates still images.
Sets the paper size and orientation. —

Click this to use the trimming
function (crops a portion of
the still image).

Selects the printer.

& ZoomBrowser EX - C:\Documents and Settings\oodMy Documentg My Pictured

File Edit Wew Tools Intermet Help

:_‘__a Indlesx Print
(5}

. Select Images Frinter Preview

MNarne:
e X |Can:m e v| Fotate Left Fiotate Right ‘ Trim Image
N
tedia Type:
|P\am Paper U| m -
Paper Size: r—
. |Letler m|
T it =1
Orientation:

@ Portrait O Landscape

1B

Copies:

Total 1 pages

- Paoe Lavout Sefinos

Calurnns 3 2
Rows: 3 |

Shooting Informstion

[ Header/Footer

Settings 4 Page: 141 ¢ &)

Click these buttons to switch between pages.

Sets the print settings for shooting information,
comments, headers, footers and page numbers.

— Sets the number of rows and columns.

Sets the number of print copies of the contact sheets.
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| Organizing Images

Applying Star Ratings and Keywords

This task allows you to apply ratings to your images from one star to three stars. The
star rating can be used as one of the search conditions, or for the selection of images
to be displayed in the Browser Window. The keyword can be used as one of the
search conditions.

1 Select the image to which you wish to apply the star rating
or keyword, and select [View/Modify Keywords] from the
[Tools] menu.

=8 Internet  Help

Manage reyworas, .,

_uskamize, ..
Preferences...

2 Place a check mark next to the keyword you wish to apply,
or click on the stars for rating.

1 View/Modify Keywords

Check or uncheck the boxes to change the way Kepwords are applied to the selected files. To add a new Keyword, bype the name in the
text field below the desired category, and press the + buttan,

Peaple Places: Events: Others:
[ Childlren [lBeach ‘[ Birthdlay

L Family ] City | Holiday

|| Friends || Home ] Party

Select the star rating to assign to the selected files

2%y © The default setting of the star rating is two stars.
4 0o You can add and delete keywords, or change the keyword list in the [Manage
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
O Windows 7 / Windows Vista: The star rating set using ZoomBrowser EX is
not related to the “Rating” setting in Windows Photo Gallery and Windows
Explorer.

Cancel
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Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the main window.

&= ZoomBrowser EX - C:\Documents and Settingshbox\My Documents\My Pictures

File Edit “ew Tools Internst Help

Tasks

,;EJ Acquire & Camera Settings
r !\"E Wiew & Classify

fz{ Edit

<| 8] 200%01_15
I = Expor l
|

Irgé;j Prirt & Email m ) <

2 Click [Classify into Folder].

—y (o
%j Slide Show |"£ Search

Zoom Mode | Seroll Made | Preview Mode

My Pictures Q Q@ R-0- ‘E‘ = ].;—e—""‘ £ Fiter -

y/a )

File Edit View Tools Internet Help

— Ty
Tasks (2] fiew Imiage fepertie %J Slide Shaw l@’f‘ Search

l 8 Acguire & Camera Settiings

Zoom Mode | Seroll Mode | Preview Mods

l Qjﬁ View & Classify ] My Pictures Q Q@ RN-0- (kN J—=m | {Frie -
“Viewr as a Slide Show ] lﬂ S
¥ 200¢_01_1!
L Rename Multiole Files J ]

(Sm MG D101 PG 1MG_0102.0°G
| 7(4 Fdit 1 -

3 Select the images you wish to classify and click [Specify
Classification Settings].

' ZoomBrowser EX - C:\Documents and Settings\box\My DocumentsiMy Pictures

File Edit View Tools Internet Help

Zoom Mode | Seroll Mode | Preview Mods

My Pictures (€] Q R-0- k(% e Rl -

[ENGAEE MG_0102.0PG

[ 9 Retum ta Main Menu T'|
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4 Specify the folder structure and the saving folder and click
[Finish].

The selected images are classified into the specified folder.

&' ZoomBrowser EX - nents and Settings\iood\My Documents\My Pictures |._||E|rz|
File Edit Wiew Tools Internet Help

B

ito Folder TEP
/ \ Al
Select Images Specity Folder Stucture ‘When classifying by shooting
y Specify folder structure date. ZoamBrowser Ex wil arily
Specify Classification Settings é’ T P classity phDIQS with shooting
2 ‘reattonthDate V‘ date information and skip over
E—:ﬂ -3 él phatos without shooting date
N Example Folder Structure: infarrnation
}I = ChDocuments and Settingshyood by Documentsihhy Pict
200% 01 16 By default, ZoomBrowser Ex

copies the original photos to the
new folders. To save space on
your computer, choose to move -

1 £ 1 | [l .
[ 3 Retum to Main Meny ] = - the photos instead.

Save to Folder

(a

“Where would you like these folders to be created?

® Curreni Folder

O My Pictures
O Specify Folder
\| ChDocuments and Setingsheodiy Documents\hy Pictures ‘/
Copy or Mowve Images =
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Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and copy
multiple files.

1 Click [View & Classify] in the main window.

1 ZoomBrowser EX - C:\Documents and SettingsbocAMy Documents\My Pictures

File Edit Yiew Tools Internet Help

—— i
Tasks @ | et Iriage roperties e Slide Show | i Search
L i) Acquire & Camera Settings J

q Lm View & lassify ]
f-' = 1] 3 2001
|

Zoam Mode | Seroll Mods | Freview Mode

My Pictures Q Q m -0 - |E| = J:-_r-—"ﬂ EW:“ Fiter — ~ |

= Erpart

l-ﬁ} Prieit & Ernail

File Edit View Tools Internet Help

— [
Tasks (2] fiew Imiage fepertie %J Slide Shaw l@’f‘ Search

l i) Acquire & Camera Settings ]
l Q—I Yiew & Classify ]
L\r’iaw & a Slide Show J

| Rename Multiple: Files

{ Classify inta Folder

Zoom Mode | Soroll Mode | Preview Mods
My Pictures Q (1] @ i B |i| 18 ]:—:—E"'T‘ ,f?:“ Filter =

|
Seaich ]
1

| ','f Fdit

MG_CI0LIPG MG_0102.9PG

3 Select the images you wish to rename and click [Specify
Rename Settings].

= ZoomBrowser EX - C:\Documents and Settings\boo\My DocumentsiMy Pictures

File Edit View Tools Internet Help

My Pictures (€} Q R-0- IEI + J—m | §Frie -
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4 Specify the settings and click [Finish].

151 ZoomBrowser EX - C:\Documents and Settings\boodMy DocumentsiMy Pictures
File Edit VYiew Tools Internet Help

. Select Images @name Settings Renaming your photos can\

E Selecthow filas should be renamed: make searching for them much

Specify Rename Settings easier

@ New MName + Number

) Shooting Date + Number E' |ZI

O Mew MName + Shooting Date + Number 123.JPG 466.JPG
© Shooting Date + New MName + Mumber }

J Je
~| Make copies offiles lZI

ADDTJPG  A_D02.JPG

Specify narme: |NEWNAME
By default ZoomBrowser Ex
3 Flotum to Mai Mumber of digits |3 | creates and renames copies of
— the original photos. To sawve
Start number; |1 |

SPECE On your computer,
choose to rename the original

Example of new file name: photos instead.

NEWRAME _001 s00¢ /

Placing a check mark here makes copies of images with new names.
The name of the original images will not be changed.

2Py o rename a folder, select a folder, and open the [Rename Folder] window by
& selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images

This task allows you to search for images by star rating, modification date, shooting
date, comment or keywords.

1 Click [View & Classify] in the main window.
You can also search for images by clicking [Search] on the Application Tool Bar.
Skip to step 3.

57 ZoomBrowser EX - C:\Documents and Settings\oodMy Documents\My Pictures
File Edit ‘“iew Tools Internet Help

Task 2 = ]
asks LA ] %‘J side Show | | & Search

t- ® | poquire & Camera Settings
| l'u Wiew & Classify

\ b =5 1 3] 200%_01_15
|
I

a4

2 Select folders and images from which you wish to search
and click [Search].

Zoom Mode | Scrall Made | Preview Mode | ) )
My Pictures Q Q H-0- k% T | §F Filer -

P ;
o Pritat & E rnail

17 ZoomBrowser EX - C:\Documents and Settings\oodMy Documents\My Pictures
File Edit Wiew Tools Internet Help

Tasks ?w:—{

) g ;e(] Slide Show z‘{ Search
7B 7 .
\ SRR g b amers aetincs I Zoom Mode: | Scrall Mode | Preview Made | )
\ JIH View & Classify l My Pictures Q Q@ R-0- l{ = j—;_ L7 Fiter -
l Wiew as a Slide Show l B
Rename Multiple Files I

\\ Claszify inta Folder

>

=F / F it
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Specify the search conditions and click [Start Search].
* The search results are displayed as thumbnails.
» Select at least one search condition.

& ZoomBrowser EX - C:\Documents and Settings\boodMy Documents\My Pictures

File Edit VWiew Tools Internet Help

(o

[ Star Rating

Match all conditions © Malch any condition

Find images with the selected star rating.

Siar Bating W ook

[ Modification Date

Find images based on the date they were last modified. =

[ 5 Reuntomanvens | @ [ ShootingDate

Find images based on the date they ware shot

Searching on ihe shooiin yiske g iew momers for lare numbers of rmages

[l Comment

Find images that hawe comments containing the following wards.

S J o

Click [Finish].
» To change the search parameters and perform another search, click [Specify
Search Conditions] and repeat steps 3-4.

51 ZoomBrowser EX - C:\Documents and SettingsboodMy Documents\My Pictures

File Edit Wew Tools Internet Help

Select Search Region

2. Specify Search Conditions

MG 0101JPE MG OLOZIPG MG OI03.0PG  IMG_0104.0FG

Start Search

rating, modification d
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» The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder.

Favorite Folders | All Falders

| 5% My Pictures
¥} zo0%_01_15

Folders Area

O The searched images will remain in this folder until ZoomBrowser EX is closed
“ZA or another search is performed, but if you delete an image in this folder, the
corresponding original image will be deleted as well.
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| Exporting Images

You can change the data type for selected still images and movies and save them as
new files. You can also export selected movies and still image properties to a text file

or copy and rename movies and still images. Furthermore, you can export still images
for use as a screen saver or a wallpaper.

Changing the File Type and Saving

1 Click [Export] in the main window.

1 ZoomBrowser EX - C:\Documents and Settings\oodMy Documents\My Pictures

File Edit Wiew Tools Internet Help

Tasks = [
E i £ il | Slide: Sh bal b
mj ide: Show | ¥ Searcl

l ]| Acquire & Camera Settings
l ﬂ'&l “Wiew & Classify

|
[ J

e
f:;-—éj Frint & Email 1 m

2 Select the export type.

Zoom Mode | Serol Modz | Preview Mode

My Pictures Q Q@ RN-0- Q_ 33 J———“P ﬁ:? Fiter =

If you selected [Backup to CD], refer to Saving on CD-R/RW Discs ([ ] 53).

&7 ZoomBrowser, EX - C:\Documents and Settingsboo\My Documents\My Pictures

File Edit View Tools Internet Help

—
Tasks e I eres ol sideshow | Search

l .._“a | Acquire & Camera Settings

Zoom Mode | Soroll Moda | Preview Mods

l T' “iew & Classify ] Iy Pictures QO0 EQ L R |E| £ J-f—"'f ,f?:“ Filter =
l ‘_é{ Edit ]
%) 20m¢_01_15
L‘; Expart }
(- )

IMG_0101.0PG IMG_0102.0PG

; .\ S
E &

IMG_0102.JPG IMG_0104.0PG

Export Shooting Properties

Export as a'Wallpaper

Export as a Screen Saver ]

Backup to CD

\< =/
fasi Print & Emall

= 1

200%_01_20

Exporting Images I 49



3 Select images and click [Specify Export Settings].

51 ZoomBrowser EX - C:\Documents and Settings\boodMy Documents\My Pictures
File Edit View Tools Internet Help

ZoomMode | Seroll Mode | Preview Mods |

My Pictures QOO0 R-6- |E| Y S e | §F it -

4 Specify the export settings and click [Finish].

The window varies depending on the selected export type in step 2.

When you have selected [Export Still Images]:

You can convert still images to another file type, resize and save them as new files.
You can select the file type from BMP, JPEG and TIFF. You can also specify a prefix to
be added to the exported still images.

& ZoomBrowser EX - C:\Documents and Settingsbood\My Documents\My Pictures

File Edit “iew Tools Internet Help

7 -
. Select Images @ge Settings “You can reduce the amDunh_ |
mermary your files use by

== [ Resize images duting expart e
Srecily Emporestiives resizing the images to a sraller
‘ Long side size.

% |;|:I E‘pixels

Short side

DZI 50D | pixels
b—sl
[] L] Change image type ‘When exporting images as

brop el —— " High JPEGS, vou can also reduce file
- s = = sizes by using a lower Cluality

setting which compresses the

Original File Size: 82.8KB image more. The images won't

e e S 0KB look as sharp butthe file sizes

will be smaller.

File Name Settings

abC oauepss
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When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

Select Images

Specify Export Settings

’ 3 Return to Main Menu ]

Sawe ta File

Select shooting propeties to export

Active AF Foints

AF Microadjustment
AF hode

AF Fange Mode
Autoexposure Bracketing
Al Aperure Walue )
Camera Body Mo,
Camera Model
Color Matrix

Color Space
Custorn Function

&

[#] Diital Fxninsure Crmnensatinn

ClearAl |

[ selectal ||

Specity file name and folder:

|C'\Dm:uments and Settingshecd, \ZBShootingProperties td

wOTE: Properties will be saved as text (“td) files.

Shooting properties are sto%

inimages a5 EXIF infarmation

ExIF stands for Exchangeable
Image File Format and is used
by most camera manufacturers.

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

B

1. Select Images

Specify Export Settings

[ 3 Retum to Main Menu ]

nd Settingsboc\My DocumentsiMy Pictures

E
ﬁcreen Saver Settings

[ Include images in the screen saver (larger file size)

e

Hegizeime 1024
Screen saver size: 0KE
[ Preview Screen Saver.. ]
Save to File

Save as

CiDocuments and Setiingsboodhy Documents\Canon Utili
ties\ZBScreenSavenZB3creenSaver.scr

Specify file name and folder

Setas default screen sawver

\NOTE' Screen savers will be saved as Windows screen saver (*scr) files.

The orderin which you seled\
photos determines their
sequence inthe screen sawer.

Ifyou selected o include
images in the screen saver. you
can reduce their size to fit a
different screen resolution

Ifyou choose notto include
images in the screen saver, and
wou then mowe orrename these
images. they will not display
when the screen saver plays.

MOTE: )

[fyyou cannot find wour screen
saverfile on the Windows
Screen Saver tab, you need to
install it.

Browse to the folder that
contains the screen saverﬂla,/
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When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be
performed if you have selected multiple images.

oomBrowser EX nts and Settingsboc\My Documents\My Pictures

STEP?2 fy the export settings

Select Images Installafion Seftings Stretching small photas can\

pixelate and distartthe photo
Specify Export Settings ® Install centered Try choosing Install centered or
Installed tiled,
O Install stretchec Tiling replicates the phota. in its

arigingl size, to fitthe desktop.
O Ingtall tiled

O Do notinstall

The wallpaperwill be saved as:

EETTTrIT—

® "2BWallpaperbmp” in the defautt directory forwallpapers

O Spadity file name and falder Sawve as

QJOTE:WaHpapers will be saved as bitmap *hmp) files. /
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Saving on CD-R/RW Discs

You can copy and save images to CD-R or CD-RW discs. The shooting information is
copied along with the images.

’0\ This function can only be used on a computer that came with a CD-R/RW drive
\&¥/ as standard equipment.

1 Place a CD-R/RW disc in the computer’s CD-R/RW drive.

2 If the following window appears, click [Cancell].

CD Drive (D:)

“Windows can perform the same action each time you insert
adisk or connect a device with this kind of file:

(7] Blank CD
“what do pou want Windows to do?

=2 e & oldel
i Lizing o
@ Take no action

[ Always do the selected action,

o e D

3 Click [Export] in the main window.

' ZoomBrowser EX - C:\Documents and Settingsboodiy Documents\My Pictures

File Edit “ew Tools Internet Help

Tasks : ;.E‘JS\'d & Shaw 'gtt Search

I el Acquire & Camera Settings

| :Hlli Wiew & Classify

I
|
L;{ Edit J

- ra

4'234_'\ Frint & Email ~I
bt

Zoom Mode 5 all Made | Preview Mods |

M |y Pictures

0 @ x 6‘ T ‘E‘ 28 J-——-—*““ uﬁ:u Filter =
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4 Click [Backup to CD].

5 ZoomBrowser EX - C:\Documents and Settings\xoax\My DocumentsiMy Pictures |Z”EHX|
File Edit View Tools Internet He\p

Tasks =i | Ve Image Propetties Slide: Shaw [xz Seatch

[: Acquire & Camera Settings

[ Fﬂ] iew & Classify
l K et

ZoomMode | Seroll Mode | Preview Mods |

by Pictures Q00 @ i B |E| 2L }_ ,‘? Filter =

%) 200%_01_15

Export 5till Images

Export Shooting Properties

Export as a Screen Saver

T

Export as a'Walpaper J

| Backup o CD [

Fririt & Email w

5 Select the folders or images you wish to save and click
[Specify Backup Settings].

)
|
|
|
|
|
|

51 ZoomBrowser EX - C:\Documents and Settings\ood\My Documents\My Pictures

File Edit VYiew Tools Internet Help

@ Backupto CD

Zoom Mode | Seroll Mods | Preview Mode|

by Pictures (RN m -0 - |E| 33 Jdgg"_,"‘ ,nﬁ':n Fiter =

4
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6 Set the backup settings and click [Start Backup].

The disc will be ejected from the drive when copying is complete.

151 ZoomBrowser EX cument: x0c\My DocumentsiMy

File Edit ‘Yiew Tools Intermet Help

Ej Backup ta GO TE

|
1. Selectimages ﬁckup Settings The speed atwhich yaur =\
. computerwiites (burns) datato
Sperify Backup Sellings Select CO-R Drive: D; v| the CO affects the CO quality,
GO Title: ‘ | I general, slower recording
DAL ACKD speeds create CDs that are less
Speed: ‘Faslest "| prone to errors
Use thi to store coples of : ; ;
toa CO for [¥]*erify after backup Itiz ahways a good ideato
choose “erify after backup'to
Use the Yerify feature 1o testthe data on the CO-R after hackup is ensure that the hackup was
complete. This will take longer. butwill deterring whether the backup was successhul
successul. =
Space on CO-R:
l] Used 0.00 B. Current Session 122.81 KB. Remaining 702.70 MB
(] I
100 200 300 400 &00 BO0
(*) Thefile sizes above are estimates only. The CO buming process
k may not be completed if the remaining space is low: / asi

@ You can add images to a CD-R/RW disc that already contains images.
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Uploading Still Images to the Camcorder

You can copy still images saved on the computer to the camcorder.

1 Connect the camcorder to the computer ([1] 25).
The still images will be added to the memory selected for the playback of still
images (built-in memory or memory card).

2 Click [Organize Images on Camera] » [Organize Images] in
the CameraWindow menu screen.

3 cClick [Upload].

# Coanon Livilities CameraWindow DC

Orgonize ImBges on Camers

4 Select the still images you wish to save and click [Open].

Open

Look in: [ 1= 2004_01_15 x| e« @B
:23
My Recent
Documen ks
Fe
| i
Desktop MG R4
My Documenl 13
My Computer
MyNetwork Fie pome [IMG_0807.0PG ~|
laces
Files of type: IJPEE ["ipa: "jpea) LJ Cancel I

* If the camcorder is already connected to the computer and the main window of
ZoomBrowser EX is displayed (immediately after download, for example), you
can start CameraWindow and display the CameraWindow menu screen by
clicking the [Acquire & Camera Settings] task button followed by [Connect to
Cameral.

0 When you upload images edited with another application, image properties
may be lost.
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Deleting Still Images on the Camcorder
B Organizing Images on the Camcorder

1 click [Organize Images on Camera] » [Organize Images] in
the CameraWindow menu screen.

2 Click the still image you want to delete, and click [Delete].

« Still images cannot be restored once they are deleted.
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| Using Various Functions

Attaching Still Images to E-mail Messages

You can attach selected stillimages to an e-mail message. If necessary, you can make
the image file size smaller.

1 Click [Print & Email] in the main window.

1 ZoomBrowser EX - C:\Documents and Settings\oodMy Documents\My Pictures

File Edit Yiew Tools Internet Help

Task. 75 - =2
asks ?‘ﬁ}’ rhie il | Slidz Show s!: Search

\ | Acquire & Camera Settings

Zoom Mode | Seroll Mode | Preview Mode

My Pictures Qa0 Eﬁ - - L}_l L j,—-f—"— ﬁ Fiker

\ ﬂkl- View & Classify
\2{ Edit

L:;;' Export

¥ 200%_01_15

IMG_0101.0PG IMG_0102.1PG
= [ =]

[Geli Print & Emil

P‘ CANON IMAGE GATEWAY 1

2 Click [Email Images].

157 ZoomBrowser EX - C:\Documents and Settings\oodMy Documents\My Pictures

File Edit View Tools Internet Help

Tasks (2] = ApErte ;?r]slide Shiow .ﬁt Search

l &) Aeouite b Camers S ettings
l HQ' Yiew & Classify

l;_{ Edit
¥} 2004_m_15

|
%
ET=R— ——
e
|

Zoom Mode | Sroll Mode | Preview Mods ) B
by Pictures Geo @ A lt-l =

L Fiter -

I

l Phota Frint
IMG_0101.0RPG IMG_D102.0PG

IMG_0103.0PG IMG_0104.0PG

Indes Print

L Print Lsing Other Software J

| EmailImages |

H TCAMMAR ARF RATFWAY W ‘

£

[20m¢ 01 20

3 Select the still images you wish to send and click [Change
Image Size].

57 ZoomBrowser EX - C;\Documents and Settingsbocd\My Documents\My Pictures

File Edit View Tools Internet Help

:§ Email Images

Zoom Mode | Seroll Mode | Preview Mods
Select Images & I 1
)

My Pictures GO0 HR-6- l{:l 4 jf_ £ Fiter -

| 2 Change Image Size

(3. Firizh

" ¥ 200%_01_15
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4 Select image size and quality, and click [Finish].

* If you selected [Using the recommended settings.], your e-mail software starts
and the selected still images appear as an attachment in the message
window. Input address, subject and your comments and send the message.

» E-mail software not supporting MAPI does not start automatically. In this case,
select [Save to Folder] in the [Custom Settings] screen and select a
destination folder for the still images.

15 ZoomBrowser EX - C:\Documents and Settingsbood\My Documents\My Pictures

File Edit View Tools Internet Help

;‘;ﬁ Email Images STEP2 Change the image size and guality

I 1. Select Images Email Setings

Feducing the total email size to
Send these images: 1MB or less insures that athers
— ) can receive yourimages, To
Bl i & Using the recommended seffings. reduce the size of the email, do
i

Change Image Size

one of the following:

© Using custom seflings.
- Click Custom Settings to
tesize or alter the quality of
images

-Return to Step 1 and
reduce your selection of
images. Consider sending

[Z1 Canfirm Cutrent Settings

* If you select [Using custom settings.], change the settings in [Custom Settings]
and click [OK].

Custom Settings

ﬁttachment Settings

Image Size: ?_Srnall [E40:480 pirels] vi
Cuality: :J High
Onginal File Size: 828 KB

Maodified Filz Size: Click Calculats button

[ Calculate ] I Preview ... J

Dizplay Warning Meszage

Dizplay warning mezzaae if the modified file size iz
larger than the magimum attachment size below.

b aximum attachment size: 1.0 I I4B

After Finizhing the T azk

(%) Attach to Email
) Save to Folder

\ (e wsatigsioavy [ bovee. | )

O To use this function, the e-mail software must be enabled as MAPI client. For
details, refer to the instruction manual of the e-mail software.

o This function uses the e-mail software configured in [Internet Options]. To
change the software, first exit ZoomBrowser EX. Next, in Internet Explorer,
select [Tools], [Internet Options] and the [Programs] tab. Set the desired
software in [E-mail] and click [OK]. (This procedure may change depending
on your Web browser.)

=
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Running a Slide Show
You can view selected still images in a slide show.
1 Click [View & Classify] in the main window.

You can also view a slide show by clicking [Slide Show] on the Application Tool
Bar. Skip to step 4.

& ZoomBrowser EX - C:\Documents and Settings\box\My Documents\My Pictures

File Edit “iew Toaols Intermet Help

— [
Tasks [2) ~ R e ] side show |8 search

L R) fcaet Camers Seltiigs J Zaam Mods i‘E:rn\I Mode | Preview Mode

My Pictures Q o HR-O- ‘E‘ 3 _|.=—=-""“ ﬁ Fiter =

| !"‘% Wiew & Classify

Pz

=y Export

Ia'gé;j Piirt & Email

di 8] 200% 0115
|
|

File Edit View Tools Internet Help

== o
Tasks a w | e Imiane eperties || Slide Show |&£ Search
l —J foute § Eamerd setiigs ] Zoom Mode | Seroll Mode | Preview Mods
Qﬁ Wiew & Classify J My Pictures Q @ a i |i| X ]:_?2_.--“ OF Filer -
| Wiew az a Slide Show . —
. ————— ¥ 200¢_01_15

Classify into Folder

IMG_0101.JPG IMG_D102.0PG
-_— — v

Search

|
{ Rename Multiple Files 1
|
|
1

| '.'! Fdit

3 Select the images and click [Setup Slide Show].

=&

Zoom M | Seroll Mode | Preview Mode

My Picturas 000 R-6- |E| 33 7.=-e-;""‘ £F Fiter »

3 Gtart Shide S

howe...

) 200201 15
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4 Select the slide show settings.

* [Image Size]: Select the size of the still images.

* [Image Information]: Select to show image information such as file name or
title.

* [Advance to Next Slide]: Select to advance manually or automatically. When
you select “Every 3 second(s)”, you can select the interval in the control below
(from 1 to 120 seconds).

* [Loop]: Select to stop the slide show after the last image or to continuously run
itin a loop.

* [Transitions]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

51 ZoomBrowser EX - C:\Documents and SettingsboodMy Documents\My Pictures

File Edit ‘Yiew Tools Intermet Help

Slide Show

1. Select Images

Transitions
Setup Slide Show

3 Start Slide Show. .

il

L ERLHIEE
| EEEOZSEE

X [|IH

Image Siza O Actual Size
: . - ® BestFit
[ 3 Retun to Main Menu ] O Maximurm Stretch

Image Information: ) Mo Information
@ Show Information
© Controls Only

] ] 4] e e e ]
L EOED

Achvance to Mext Slide: O On dlicking the left mouse button
& Every 3 second(s)
E

B cClick [Start Slide Show].

Click @ in the lower right corner to end the slide show.
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Adding Sound to a Still Image

* You can add a sound to an image. The sound file that can be added to the image
must be WAVE type (extension “.wav”).
* The sound cannot be played back on the camcorder.

1 In the main window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

\.-'iew Tools  Inkernet  Help
Copy Chrl+C

Copy ko Folder. ..
Move ko Folder, ..

Select Al Chrl+A

Clear Selection Chrl+R

Rokate, ..
Rokake dccording o Rotakion Information

Edit Image. ..

2 Click [Add].

1 Sound

Currently Selected Sound File:

(] 4 ] | Cancel

3 Select the sound file and click [Open].
4 cCiick [OK].

» The sound file will be copied to the same folder as the image.
« To play back the sound, select an image with a sound icon and select [Play
Sound] from the [Edit] menu.

2Py © Toremove sound from an image, select [Remove] on the Sound window in
&7 step 2. disappears and the copied sound file will be deleted.
o The [Play Sound] window appears and plays back the sound.
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Reviewing and Changing the Owner Name of the
Camcorder

You can change and confirm the owner’s name of the camcorder.
1 Connect the camcorder to the computer (1] 25).
2 Click [ a Preferences] in the CameraWindow menu screen.

3 Click the [General] tab, and then click the [Connected
Camera] tab.

Edit

Set the name of the camera’s ownar, When you shoot using a camera with the owner's name set,
the owner's name will be racorded in the imaga files.

e — 1 -

4 Click [Edit] and enter the camcorder’s owner’s name and
click [Set] » [OK].

Input the camcorder’s owner’s p—

n a me h e r’e (u p to 3 1 Ch a ra Cte rs) . Set the name of the camera's owner. When you shoot using a camera with tie wrn = 3 name set,

t
the owner's name will be recorded in the image files.
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| Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

0 You must have authorization as a Computer System Administrator to uninstall
programs.

Uninstalling ZoomBrowser EX

Other programs in the [Canon Utilities] folder can also be uninstalled in the same way.

1 Click the Windows [start] menu and select [All Programs] »
[Canon Utilities] » [ZoomBrowser EX] and [ZoomBrowser

EX Uninstall].
| @‘; II:':'::I;teExplnrer | L/ T Resuments

b .
~ } My Pictures
@9 E-mail B At At

o Cutlook Express @ Set Program Access and Defaults
B0 Windows Catalog

“H el % windows Update

=\ ToomBrowser Ex I Accessaries 3
-Iﬂ @ames »
I startup »

& Internet Explorer
W WS Explorer

4] Cutlook Express
po PRemate Assistance

@ Windows Media Player

3 tifind Messenger

All Programs B B Canc ilities ‘I‘:] CameraWwindow

3 £ ZoomBrowser EX
B oot ] rurn o o -

% Mermory Card Utility [Z] ZoomBrowser EX Readme
‘@ CANON iMAGE GATEWAY Task

2% © Uninstall also [Canon Internet Library for ZoomBrowser EX] when you have
& uninstalled ZoomBrowser EX:
1) Windows 7 / Windows Vista: Open the Start menu and select [Control
Panel] and [Uninstall a program].
Windows XP: Open the [start] menu and select [Control Panel] and
[Add or Remove Programs].
2) Select [Canon Internet Library for ZoomBrowser EX] and click
[Uninstall/Change] or [Change/Remove].
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| Troubleshooting

Connection

Camcorder is not recognized when connected to the computer.

=> There is no memory card in the camcorder.
Insert a memory card into the camcorder.

= The camcorder is not set to the correct mode.
Set the camcorder to still image playback mode.

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([ 1] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

= If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

ZoomBrowser EX Operation

Cannot download still images.
= The camcorder is not set to the correct mode.
Set the camcorder to still image playback mode.

Image files or folders do not appear in ZoomBrowser EX.
= Images or folders shown in ZoomBrowser EX and the actual file contents
may be different when an image file has been moved or copied using
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].
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